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Chapter 1 

Introducing Rapid Compliance 

Rapid Compliance activates essential features of two Logical Apps AppsRules prod-
ucts, AppsAccess and AppsControl, enabling users to detect segregation-of-duties 
conflicts and to audit changes made to data-entry fields in Oracle Applications.  

AppsAccess 
AppsAccess defines and detects segregation-of-duties conflicts within an organiza-
tion, either preventing them from occurring or uncovering them so that they can be 
monitored. AppsAccess identifies conflicts at both the responsibility and function 
levels. 

AppsAccess users create “conflict rules,” each of which specifies two responsibilities 
or functions that should not both be assigned to an individual person. Users may cre-
ate rules one at a time in a form called the Conflict Matrix, or upload already-created 
rules from an Excel spreadsheet and adapt them as needed. 

In the Rapid Compliance adaptation of AppsAccess, each conflict rule applies one of 
two “control types” — Prevent or Allow with Notification. These determine the 
action to be taken when an Oracle Applications user is assigned duties that violate a 
conflict rule: 

• A Prevent rule denies access to conflicting responsibilities or functions. When a 
user is assigned responsibilities that trigger a Prevent rule, AppsAccess sets their 
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end dates to match their start dates, thus ensuring there is no period during 
which the user has access to conflicting elements. 

• An Allow with Notification rule permits access to conflicting responsibilities or 
functions, but alerts designated reviewers that the conflict exists.  

Once conflict rules are defined, an AppsAccess user “generates conflicts” — causes 
AppsAccess to evaluate current Oracle Applications users and note those who are in 
violation of conflict rules. AppsAccess then lists the conflicts generated by each rule 
in a form called User Conflicts. It treats these conflicts in either of two ways: 

• A user may have been assigned responsibilities or functions before a rule was 
created to define them as conflicting. If so, the User Conflicts form displays ap-
propriate status for the conflict: “Prevent” or “Allow with Notification.” Records 
of conflicts are also published in AppsAccess reports; administrators would then 
use information from the reports to make appropriate adjustments in other sys-
tems — essentially, setting a user’s responsibility end date to the current date for 
a Prevent conflict.  

• A user may have been assigned responsibilities or functions after a rule was cre-
ated to define them as conflicting. In this case, AppsAccess permits the assigner 
an opportunity to change the assignment; if he submits it anyway, AppsAccess 
automatically applies end dates if the control type is Prevent, removes them if the 
control type is Allow with Notification, and records appropriate status in the User 
Conflicts form. 

Three AppsAccess reports provide information for the resolution of conflicts: The 
Conflict Summary Report shows the number of conflicts generated for each respon-
sibility and so helps in establishing resolution priorities. The Responsibilities with Con-
flicts Report lists the conflicts within each responsibility. The User Conflicts Report 
presents information on the status of conflicts for individual users.  

Two remaining reports are useful for auditing: The Conflict Matrix report lists 
conflict rules and, for each rule, displays the values that define it. The Application 
Conflict Report provides status information about each user affected by each rule. 

AppsControl 
The Rapid Compliance adaptation of AppsControl monitors changes to fields in 
Oracle Applications. It enforces rules — one for each field — that apply a single 
“control type,” called Audit. Users can change field values freely, but AppsControl 
tracks the changes for presentation in reports.  

Users can create rules one at time in a form called the AppsControl Wizard, or 
upload already-created rules from an Excel spreadsheet and use the Wizard to con-
firm that they have been uploaded correctly. 

AppsControl provides a Control Listing report, which presents information about 
the control rules that have been implemented. For information about changes to the 
values of controlled fields, one would use the reporting feature of a third AppsRules 
product, AppsAudit.  



 Chapter 1: Introducing Rapid Compliance 

Rapid Compliance User’s Guide  3 

Other AppsRules Applications 
Because Rapid Compliance is a focused adaptation of AppsRules, it activates only 
those features that support targeted AppsAccess and AppsControl functionality, and 
disables all others: 

• The AppsForm and AppsFlow applications can be opened, but are read-only. 
The user cannot insert or modify records in AppsForm or AppsFlow. 

• In AppsAudit, reports document changes to values stored in database tables. 
Database columns hold values entered in form fields, which in turn may be sub-
ject to AppsControl rules. So in Rapid Compliance, one uses AppsAudit reports 
to review changes to the values of fields that are subject to AppsControl rules.  

Users can also set the “state” of audit groups (a group being a set of database 
tables), as well as define lookup values (meaningful values that match up with 
audited values, such as a person’s actual name in place of a numeric identifier). 
Other AppsAudit features are disabled. 

Even in AppsAccess and AppsControl, some features are disabled. (These are to be 
enumerated in subsequent chapters.)  

Starting Rapid Compliance 
To start Rapid Compliance: 

1 Log on to Oracle Applications. 

2 Select the LogicalApps responsibility in the Oracle Applications list. (Ensure first 
that the LogicalApps responsibility is available to you.) 

3 A selection of Logical Apps applications appears. Depending on what you want 
to do, click on one of the following: 

• AppsAccess — Define Conflict Rules, to create or view rules that define 
separation-of-duties conflicts, evaluate them (“generate conflicts”), or view 
the conflicts that result. 

• AppsControl Wizard, to create or view change-control rules. 

• AppsRules, to run AppsAudit reports (or set audit-group states or define 
lookup values). 

If you close a Rapid Compliance application, you can restart it or open another by 
double-clicking on one of these options in the Logical Apps Navigator, which re-
mains in the background on your screen. (Or, click on the option once, and then 
click on the Open button.) 
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Chapter 2 

Segregation of Duties 

In the Rapid Compliance adaptation of AppsAccess, you can create or upload rules 
that define segregation-of-duties conflicts. You can evaluate them and view records 
of the conflicts that result. You can define “global subscribers” — submenus, func-
tions, data groups, operating units, or users who are exempt from conflict rules. As 
you assign responsibilities to users in the Oracle Applications Users form, you can 
determine whether those assignments violate conflict rules. You can run reports of 
AppsAccess processing. 
You cannot, however, approve or reject conflicts, so forms that enable users to set 
the status of conflicts, which are available in a full AppsAccess implementation, are 
disabled in Rapid Compliance. These are the Actions form and the Mass Update form. 

Finding Conflict Rules 
When you start AppsAccess, both the Conflict Matrix and a Find Conflict Rules 
form appear on screen, with the Find form initially active. (It’s shown at the top of 
the next page.)  
You can use this form to load existing conflict rules into the Conflict Matrix. To 
search for all rules, simply click on the Find button. Or to search for a selection of 
rules, complete the following steps: 
1 Fill any combination of the following boxes. 

• Conflict Rule Name: From the list, select a rule name to return the single rule 
that matches that name. Or leave the field blank to search among all rules. 
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• Application: From the list, select an Oracle application to find rules involving 

that application (as either of two applications to which conflicting responsibil-
ities or functions may belong). Or leave the box blank to see rules involving 
any application. 

• Entity Type: Select Function or Responsibility to find rules defining conflicts 
in one entity or the other, or leave the box blank to see rules for both types. 

• Entity: From the list, select a function or a responsibility to search for rules 
involving that entity (as either of the two conflicting entities). Or leave the 
box blank to search for rules involving any function or responsibility. The 
values you can select depend on your selection in the Entity Type box. 

• Reviewer: From the list, select a person to find rules for which that person is 
the designated conflict reviewer. Or leave the box blank to see rules for which 
anyone is a designated reviewer. 

• End-Dated Conflicts: Select Y (for yes) to find rules for which conflicts are 
end-dated or N (for no) to find rules for which conflicts are not end-dated. 
Or leave the box blank to search for both types of rule. 

• Conflicts Exist: Select Y (for yes) to find rules for which conflicts exist or N 
(for no) to find rules for which no conflicts exist. Or leave the box blank to 
search for both types of rule. 

• Same OU: Select Y (for yes) to find rules that apply within operating units or 
N (for no) to search for rules that apply across operating units. Or leave the 
box blank to find both types of rule. 

• Same SOB: Select Y (for yes) to find rules that apply within sets of books or 
N (for no) to search for rules that apply across sets of books. Or leave the 
box blank to find both types of rule. 

• Control Type: Select Prevent or Allow with Notification to search for rules 
of either type. Or, either select or clear both check boxes to search for rules 
of both types. 

2 Click on the Find button. (Or, to discard the filtering selection you have made 
and start over, click on the Clear button.) 
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After being used, the Find Conflict Rules form remains open in the background. To 
bring it to the foreground and use it again, click on it (drag any other forms, such as 
the Conflict Matrix, out of the way). If you close it, you can reopen it: Click on View 
in the menu bar, then Find in the View menu. Or, click on the Find icon, located 
second from the left in the tool bar. (It looks like a flashlight.) 

Note 
Because approval groups as well as the Approval Required and Allow with 
Rules control types do not apply to Rapid Compliance, options to select 
these items as search filters are disabled in the Find Conflict Rules form. 

Creating Conflict Rules Manually 
In broad terms, creating a conflict rule involves specifying two conflicting “entities,” 
either responsibilities or functions; noting the applications to which those entities 
belong; and selecting a control type, a reviewer, and a few other parameters. You can 
complete all these tasks in the Conflict Matrix, which opens when you select the 
AppsAccess — Define Conflict Rules option in the Logical Apps Navigator. 

 
To create a conflict rule in the Conflict Matrix: 

1 Activate a row in the grid on the Conflict Matrix. Use any of these methods: 

• If the Conflict Matrix grid contains any empty rows, click in the first one. 

• Click on the New button, which is first on the left in the tool bar. 

• Click on File in the menu bar, then on New in the File menu. 

• Open the Find Conflict Rules form and click on its New button. 

Once a row is active, some fields in the Conflict Matrix take on a yellow coloring, 
and others white. Yellow fields require input; white fields are optional. 

2 Type a unique name for the rule in the Conflict Rule Name field. 
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3 In the Entity Type list box, select Responsibility or Function. 

4 Select the “base” entity — the first of the two entities your rule is to define as 
conflicting. Use either of two methods: 

• In the Entity list of values, select a responsibility or function. (The list con-
tains only one type or the other, depending on the choice you made in the 
Entity Type list box.) When you do, AppsAccess fills the Application box 
with the name of the application to which the entity belongs. 

• In the Application list of values, select an application. AppsAccess then limits 
the values available in the Entity box to those belonging to the application you 
selected (and, of course, of the type you chose in the Entity Type list box). 
Select the one you want. 

5 Select the conflicting entity — the second of the two entities your rule is to 
define as conflicting. Use either of the methods you used to select a base entity, 
but this time in the Conflicting Application and Conflicting Entity lists of values. 

6 In the Control Type list box, select the control type you want to apply to the rule 
— Prevent or Allow with Notification. 

7 In the Reviewer list of values, select the workflow role (person) who is to review 
individual conflicts generated by the rule. Although the review of conflicts applies 
only to a rule of the Allow with Notification control type, you must select a 
reviewer even if you are configuring a Prevent rule. Workflow roles are configured 
in Oracle Applications. 

8 Select the Same OU check box if you want the rule to apply only within individ-
ual operating units. Select the Same SOB check box if you want the rule to apply 
only within individual sets of books. Clear the appropriate check box if you want 
the rule to apply across operating units or sets of books. 

9 In the Reason box, type an explanation of the business risk addressed by this con-
flict rule. (This reason appears in the LA AppsAccess Conflict Matrix Report.) 

10 In the Start Date field, select a date on which the rule takes effect. In the End 
Date field, select a date on which the rule expires. 

By default, Start Date is set to the date on which you create the rule and End Date 
is blank, so the rule would take effect immediately and remain in effect indefinitely. 
To change these values, select a date in the pop-up calendar that appears when 
you click on either list-of-values icon. Or type a date in the format configured for 
your instance of Oracle Applications. 

11 Save the conflict rule: Click on File in the menu bar, then on Save in the File 
menu. Or click on the Save icon, located fourth from the left in the toolbar. 

Note 
On the Conflict Matrix, the Approval Group list of values and the Mass 
Update and AppsForm Rules buttons are disabled because they do not apply 
to Rapid Compliance. 



 Chapter 2: Segregation of Duties 

Rapid Compliance User’s Guide  9 

Creating Global Subscribers 
You can specify submenus, functions, data groups, operating units, and users who 
are exempt from conflict rules. Such exclusions can ensure that query-only access to 
Oracle Applications features does not trigger conflict rules, even when standard ac-
cess to the same features would. Or they may avoid the generation of conflicts that 
need not be tracked (such as for support personnel, who might have super-user ac-
cess, but who do not actually carry out the conflicting responsibilities or functions). 

Items designated for exclusion (or, in one case, inclusion) are called global subscrib-
ers. To select them, click on the Global Subscribers button in the Conflict Matrix. 
Then, in a Global Subscribers form, click on the tab for a subscriber type. 

Operating Units 
You can select operating units either to be included in, or excluded from, conflict-
rule processing. These selections apply to operating units assigned to users, respon-
sibilities, applications, or sites through use of the MO: Operating Unit profile option 
in the system administrator responsibility. The option may be set simultaneously at 
any or all of these levels, and the active setting is the one at the most narrowly 
focused level (first user, then responsibility, then application, then site). 

1 In the Global Subscribers form, click on the Include/Exclude Operating Units 
tab: 

 
2 Select operating units in the list-of-values fields under either of the Include and 

Exclude headings. It is permissible to have entries in both lists simultaneously. 

3 Select or clear the Active check boxes next to the entries: 

• If Active check boxes are selected under the Include heading, the correspond-
ing operating units are eligible for conflict-rule processing and all others are 
excluded. 

• If Active check boxes are selected under the Exclude heading, the corre-
sponding operating units are excluded from conflict-rule processing, and all 
others are included. 

Do not select Active check boxes simultaneously under both the Include and Ex-
clude headings. Otherwise you will be unable to save the subscriber configuration. 
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Submenus 
A submenu under one menu may provide query-only access to functions, even 
though the same submenu under another menu provides write access to the same 
functions. A conflict rule that includes such a function would trigger conflicts for all 
instances of the function — rightly when a user has write access, but falsely for 
query-only access. 

To exclude just the query-only functions from conflict-rule processing, create 
submenu subscribers: 

1 In the Global Subscribers form, click on the Exclude Sub-Menus/Functions tab: 

 
2 Make selections in the Menu Name, Sub-Menu Name, and (optionally) Function 

Name list boxes. (The last of these and other fields come into view as you scroll 
the form to the right.) AppsAccess supplies corresponding values in the User 
Menu Name, User Sub Menu Name, and User Function Name fields. 

This exclusion feature recognizes only direct parent-child relationships: 

• To exclude a submenu, specify that submenu and its immediate parent menu; 
use the Sub-Menu Name and Menu Name fields (respectively). To exclude a 
submenu is to exclude all functions available from that submenu. 

• To exclude a single function, specify that function and its immediate parent 
submenu; use the Function Name and Menu Name fields (respectively). 
Note that you would include the submenu name in the Menu Name field and 
would leave the Sub-Menu Name field blank. 

3 Select the Active check box to exempt the query-only instance of the function or 
functions from conflict rules, while leaving write-enabled instances subject to con-
flict rules. Or, clear the check box to deactivate the exemption. 

Data Groups 
AppsAccess includes the capability to evaluate conflict rules against data groups. To 
eliminate false conflicts that can occur when custom responsibilities are assigned to 
query-only data groups, you can exempt data groups from conflict-rule processing: 



 Chapter 2: Segregation of Duties 

Rapid Compliance User’s Guide  11 

1 In the Global Subscribers form, click on the Exclude Data Groups tab: 

 
2 In the Data Group lists of values, select the group that is to receive the exclusion. 

If a description was written when the group was created, it appears by default in 
the Description box. If no description was written, the box remains blank. The 
Description box does not accept direct input. 

3 The Active check box is selected by default. Leave it selected for the exclusion to 
take effect. Clear it (click on it so that no check mark appears) to reserve an exclu-
sion for the group, but not have it take effect at present. 

Users 
You can exclude individual users from conflict-rule processing: 

1 In the Global Subscribers form, click on the Exclude Users tab: 

 
2 In the User Name list of values, select the ID of the user who is to receive the 

exclusion. 

If a description of the user was written when the user ID was created, it appears 
by default in the Description box. If no description was written when the user 
ID was created, the box remains blank. The Description box does not accept 
direct input 

3 The Active check box is selected by default. Leave it selected for the user exclu-
sion to take effect. Clear it (click on it so that no check mark appears) if you want 
to reserve a user exclusion for the user, but not have it take effect at present. 
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Finishing the Subscriber Configuration 
When you finish working in the Global Subscriber forms, save the subscribers 
you’ve created: Click on File in the Oracle Applications menu bar, then on Save in 
the File menu. (Once you’ve created and saved a subscriber, you cannot delete it, 
although you can deactivate it by clearing its Active check box.) Then close the 
Global Subscriber forms: Click on the × symbol in the upper right corner. 

You can print a report that lists all user exclusions (see page 40). 

Uploading Conflict Rules from a Spreadsheet 
Rather than create rules one at a time in the Conflict Matrix, you can select rules in a 
Microsoft Excel spreadsheet, edit them in the spreadsheet to contain values appropri-
ate for your site, and then upload them all at once. You need to know the name of 
the ODBC driver that enables you to connect to your Oracle system. 

To prepare the spreadsheet for uploading: 

1 Open the AppsAccess LA_SOD spreadsheet. 

 
2 In the upper left corner of the Access Load Values sheet, provide the ODBC 

driver name, connect string, Apps user name, and Apps password. 

3 Click on the Update Data button. The spreadsheet is populated with up to 
65,536 rows of rule data. (Owing to Excel limitations, this is the maximum 
number possible.) 

4 Review the rules and select those you want to upload: In the Load column, select 
the value Y for rules you want and N for rules you don’t want. 

5 Edit the Control Type, Reviewer, and Reason values as appropriate for the rules 
you are uploading. You cannot change the values in other columns. 

In particular, SYSADMIN is the default conflict reviewer for all rules in the spread-
sheet. For each rule, change this value to an appropriate person or approval group. 
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6 On the Tools menu, click Create CSV for AppsAccess. In response to prompts, 
enter a file name and location. Click OK to save the file. 

Note 
The Create CSV for AppsAccess option appears in the Excel Tools menu 
only if the macro security level for Excel is set to low. To effect this setting, 
click on Tools in the Excel menu bar, then on Options in the Tools menu. 
In the Options window, click on the Security tab. In the Security panel, click 
on the Macro Security button. A Security window opens; in its Security Level 
panel, click on the Low radio button. Then close the Security and Options 
windows — click on the OK button in each. 

To upload the file you’ve prepared: 

1 As an admin user, upload the CSV file to your UTL directory on the database 
server. 

2 Open the Navigator in the Logical Apps responsibility. Click on View in the 
menu bar, then on Requests in the View menu. 

3 A Find Requests form opens. Click on its Submit a New Request button. In the 
Submit a New Request dialog, click on Single Request and then on the OK but-
ton. 

4 A Submit Request form opens. In its Name list of values box, select LA 
AppsAccess Load Conflict Rules. 

5 A Parameters form appears. In it, supply the following values: 

• Load: From the list, select Yes to load the data. (The value No would validate 
the data without loading it.) 

• Flat Filename: Enter the name you created for the CSV file. 

• Flat File Path: Enter the location you established for the file. 

• Log Details: From the list, select Yes to created a detailed log or No to create 
a more cursory log. Typically, you would select Yes to troubleshoot a prob-
lem with an upload operation. 

6 In the Submit Request form, click on the Submit button. At the next prompt, 
make a note of the request number, then click on No to return to the Find 
Requests form. 

7 To view the log, click on the Specific Requests button. Type the ID number for 
your request in the Request ID field, and click on the Find button. 

8 A Requests form shows the status of your request. When it informs you that the 
request is completed (you may have to click on the Refresh Data button), click 
on the View Output button. 
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Generating User Conflicts 
Once conflict rules are defined and saved, the next step is to generate conflicts — to 
have AppsAccess search through users’ work assignments for violations of the rules. 
AppsAccess evaluates all conflict rules that have been saved, not only rules that may 
currently be visible in the Conflict Matrix. 

For the first of two methods to generate user conflicts, complete these steps: 

1 Open the Define Conflict Rules copy of the AppsAccess Conflict Matrix, if it is 
not already open. It is unimportant whether the Matrix displays any conflict rules. 

2 Click on the Generate User Conflicts button (located at the lower left of the 
Conflict Matrix form). 

3 A message informs you that a generate-user-conflicts request has been submitted. 
Make a note of the request ID, and click on the OK button to clear the message. 

 
The Generate User Conflicts button is active only in the Define Conflict Rules copy 
of the Conflict Matrix. However, you can use another method to generate conflicts: 
Use the Requests option on the View menu to launch the LA AppsAccess Generate 
User Conflicts concurrent request. For a full description of the procedure for initiat-
ing a concurrent request, see “Generating Reports and Requests” on page 33. 

Reviewing User Conflicts 
To view the conflicts you’ve generated, you need to refresh the Conflict Matrix — in 
effect, to reload the rules in which you are interested, even if they were already loaded 
in the Conflict Matrix when you initiated the generate-user-conflicts request. To re-
view user conflicts: 

1 Click in the Find Conflict Rules form to make it active. Use it to locate conflict 
rules in which you are interested and load them into either copy of the Conflict 
Matrix. (See page 5.) 
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2 When users’ work assignments violate a rule, AppsAccess places a check mark in 
a Conflicts Exist box for that rule. The check box is located to the right of the 
Conflict Matrix row in which the rule is defined: 

 
3 Select one of the check-marked rules. (Click on the row in which it is defined; 

note that a rectangle to its left turns blue.) Then click on the User Conflicts but-
ton. The following User Conflicts form presents configuration details for the rule 
you selected, and a list of users whose responsibility assignments violate it. Each 
user’s status is set either to Prevent or to Allow with Notification, depending on 
the control type of the rule that generated the conflicts. 

 
Because Rapid Compliance does not enable user to approve or reject a conflict, the 
Action/Action History button is disabled. If existing responsibility assignments trig-
ger a Prevent rule, you need to open the Users form and, for each user, end-date the 
offending responsibility there.  
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Assigning Responsibilities to Users 
When an administrator opens the Oracle Users form to create a new user or to assign 
new responsibilities to an existing user, AppsAccess evaluates the assignment for con-
flicts before it is finalized, then presents an option to submit or cancel it: 

1 With the User form open, a system administrator selects a user and, in the grid 
accessible from the Responsibilities tab, assigns responsibilities. (See Oracle doc-
umentation for information on accessing the Users form and configuring users.) 
Both the start and end dates for these responsibilities are set by default to the 
current date, and cannot be modified directly. The administrator saves the new 
assignments. 

2 The administrator clicks on Actions in the menu bar, then on Assign Responsi-
bilities in the Actions menu. 

3 An Activate Responsibilities form opens; it presents a copy of the responsibilities 
listed in the Users form, but allows the administrator to change the end dates. 

 
4 The administrator removes end dates (or alters them to a future date) for a 

selection of responsibilities, and so provisionally grants access to them. He then 
clicks the Initiate Conflict Analysis button. 

5 An Initiate Conflict Analysis form provides data about responsibilities for which 
the administrator changed end dates, noting those for which no conflict exists, 
and listing all conflicts in which the responsibilities are involved. A message in a 
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Status field states that end dates will not be removed for a Prevent conflict, or 
that end dates will be removed for an Allow with Notification rule. 

 
6 The administrator may, at this point, take either of two actions: 

• Avoid assigning conflicting responsibilities by restoring the end dates he 
removed. 

To do this, he would click the Cancel button in the Initiate Conflict Analysis 
form, click the Cancel button in the Activate Responsibilities form, and click 
the No button in a prompt to save changes. He can then reselect the Assign 
Responsibilities option in the Actions menu and try granting access to a 
different selection of responsibilities. 

• Accept the selection of responsibilities, even if it contains conflicts. To do so, 
he would click the Submit button in the Initiate Conflict Analysis form. 

For responsibilities that have no conflicts or have Allow with Notification 
conflicts, AppsAccess sets end dates in the Users form to match those selected 
in the Activate Responsibilities form. For responsibilities involved in Prevent 
conflicts, original end dates are made permanent in the Users form.  

Note 
In the full implementation of AppsAccess, “where used” options in a Tools 
menu enable a user to display a menu tree leading to each of the “base” and 
“conflicting” entities of a conflict as defined by an AppsAccess rule. These 
could assist in determining the locations of functions that conflict even though 
they belong to one responsibility, so that one or both could be excluded. 
However, the “where used” options are disabled in Rapid Compliance. 
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Chapter 3 

Change Control 

Rapid Compliance uses features of two AppsRules applications to implement change 
control in Oracle Applications. For the most part, you work directly in AppsControl, 
creating or uploading rules that monitor changes to the values of fields in Oracle Ap-
plications forms. AppsControl, however, manipulates AppsAudit. For each form field 
that is subject to an AppsControl rule, AppsAudit tracks changes in a corresponding 
database column — the one that stores values entered or displayed in the form field. 
The AppsControl rule selects that column for auditing in AppsAudit, and ensures that 
its table belongs to an “audit group.” Directly in AppsAudit, you can define and view 
reports on changes to columns contained in audit groups, and so to change-controlled 
fields. 

An AppsControl rule applies a “control type,” and in Rapid Compliance only one type 
— Audit — is available. A rule of this type monitors changes to fields, but allows 
users to make changes freely. The full implementation of AppsControl provides two 
additional control types: Reason Code both tracks each change and requires the user 
to give a reason for it, and Approval not only does both, but also requires another user 
to approve the change. Both these control types are disabled in Rapid Compliance. 

It’s expected that the principal means of generating change-control rules in Rapid 
Compliances is to upload “content” — an extensive set of rules — from an Excel 
spreadsheet. In support of this method, Rapid Compliance validates rules during an 
upload operation, ensuring that only those of the Audit control type are accepted. 
However, users can also create Audit rules one at a time in a form called the 
AppsControl Wizard. 



Chapter 3: Change Control 

20 Rapid Compliance User’s Guide  

 

Uploading Rules from a Content Spreadsheet 
To upload AppsControl rules from a content spreadsheet, first review and prepare 
them: 

1 Open the spreadsheet in Microsoft Excel and review it with your Professional 
Services team member. Select the rules that target fields for which you want to 
implement controls. Type the letter Y in the Upload column for each of these 
rules. (Remember that you can upload only rules of the Audit control type.) 

2 Create a flat file containing the rules you’ve selected: From the Tools menu in 
Excel, select the Create CSV for AppsControl option. Specify the destination for 
the CSV file and select the Save button. 

Note 
Like the companion option in AppsAccess, the Create CSV for AppsControl 
option appears in the Excel Tools menu only if the macro security level for 
Excel is set to low. To effect this setting, click on Tools in the Excel menu 
bar, then on Options in the Tools menu. In the Options window, click on 
the Security tab. In the Security panel, click on the Macro Security button. A 
Security window opens; in its Security Level panel, click on the Low radio but-
ton. Then close the Security and Options windows — click on the OK button 
in each. 

3 A control total message displays the number of rules written. To verify the 
completeness of your upload file, compare this with the number of rows you 
selected. 

To upload the file you’ve prepared: 

1 FTP the CSV file to the /usr/tmp UNIX directory of the instance in which the 
rules are to be used. 

2 Open the Navigator in the Logical Apps responsibility and run the LA AppsControl 
Data Load concurrent request. (For a full description of the procedure for initiat-
ing a concurrent request, see “Generating Reports and Requests” on page 33.) 
Supply the following parameters: 

• File Name: Type in the name of the CSV file to be loaded. This parameter is 
mandatory. 

• File Location: Type in the UNIX path to the file to be loaded. This parame-
ter is mandatory. 

• Debug Mode: Select Yes to enable debug functionality for the load, or No to 
disable the functionality. 

• Load Data: Select Yes if the data is to be loaded into the AppsControl rule 
repository. Select No if this is a data validation run only. 

3 Open AppsControl. Click on Tools in the menu bar, then on AppsAudit Com-
pile Audit Objects in the Tools menu. A pop-up note informs you of a concur-
rent request ID number. Click on the OK button to clear the message. 
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Creating Control Rules Manually 
The AppsControl Wizard enables you to create new control rules, to view existing 
rules, or to confirm that content-spreadsheet rules have been uploaded correctly.  

Finding Control Rules 
When you start AppsControl, both the AppsControl Wizard and an AppsControl 
Find form appear on screen, with the Find form initially active.  

 
If you intend to create new control rules, you can simply click on its New button; in 
this case, the Wizard becomes the active form but displays no rule data. 

However, you can also use the Find form to load existing control rules into the 
AppsControl Wizard: To search for all rules, simply click on the Find button. Or, to 
search for a selection of rules, complete the following steps: 

1 Supply values in any combination of the filtering fields: 

• Application Name: From the list, select an Oracle Application containing 
fields for which you want to view control rules. Or, leave the box blank to 
select all applications. 

• User Form Name: This box presents a list of the form names that are visible 
to the user of an Oracle Application. Choose one containing fields for which 
you want to view control rules. Or, leave the list box blank to select all 
forms. 

• Form Name: This box presents a list of the form names that are used internally 
by the system. If you’ve made a selection in the User Form Name box, 
AppsControl automatically fills this box with the corresponding system form 
name. If you make a selection in this box, it overrides the value in the User 
Form Name box — AppsControl displays fields from the form identified by 
the system form name. You can leave this box blank to select all forms. 

• Block Name: From the list, select a form block containing fields for which 
you want to view control rules. Or, leave the box empty to select all blocks in 
a form (if you selected one in the Form Name or User Form Name box), or 
all blocks in all forms (if you made no form-name selection), or all blocks in 
all applications (if you made no application selection). 
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2 After entering values, click the Find button. Or, to discard the filtering selection 
you have made and start over, click on the Clear button. 

After being used, the Find form remains open in the background. To bring it to the 
foreground and use it again, click on it (drag any other forms, such as the Wizard, 
out of the way). If you close it, you can reopen it: Click on View in the menu bar, 
then on Find in the View menu. Or, click on the Find icon, located second from the 
left in the tool bar. (It looks like a flashlight.) 

Determining Internal Names for Items Used in Rules 
As you work with the AppsControl Wizard, you need to know the “internal” names 
for Oracle Applications forms, blocks, and fields — for example, APXVDMVD for the 
Enter Vendor form, VNDR for the block on the Enter Vendor form that contains a 
Supplier Name field, and VENDOR_NAME_MIR for the field itself. 

To discover the internal name for an Oracle Applications form, complete these steps: 

1 Navigate to the form whose internal name you want to know. 

2 Select Help in the menu bar, then About Oracle Applications in the Help menu. 

3 An About Oracle Applications window opens. In it, scroll to the Current Form 
section and take note of the Form Name — in the example shown below, 
APXVDMVD. 

 
4 Click on the OK button to close the form. 

To discover the internal names for blocks and fields, complete these steps: 

1 Click on a field if you mean to determine either its name or the name of the 
block that contains it. 

2 Select Help in the menu bar, then Diagnostics in the Help menu, then Examine. 

3 An Enable Diagnostics dialog prompts for the Oracle password. Enter the pass-
word for your instance and click on the OK button. 

4 An Examine Field and Variable Values form opens. Take note of the internal 
block and field names for your selection. 
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5 Click on the OK button to close the form. 

Creating Control Rules 
To create a control rule in the AppsControl Wizard, first create an empty row in the 
upper grid of the form that appears when the Change Element tab is selected. If you 
clicked on the New button in the Find form, you’ve already accomplished this. Other-
wise, use any of the following methods: 

• If the Change Element grid contains any empty rows, click in the first one. 

• Click on the New button (first on the left in the Oracle Applications tool bar). 

• Click on File in the Oracle Applications menu bar, then New in the File menu. 

 

Selecting a Block of Controllable Fields 
In the empty row you’ve created (in the upper grid under the Change Element tab), 
specify a block of fields in an Oracle Applications form. Enter values in these fields: 

• Form Name: This box accepts form names that are used internally by the system. 
Select one containing fields for which you want to create control rules. When 
you make a selection in the Form Name box, AppsControl automatically inserts 
corresponding entries in the User Form Name and Application Name boxes. 
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• User Form Name: This box accepts user form names (those visible to the user of an 
Oracle Application). If you made a selection in the Form Name box, AppsControl 
has inserted the correct User Form Name here. If not, select or type a user form 
name here. 

• Application Name: This box accepts the name of the Oracle Application that 
uses the form you specified in the previous two boxes. If you began by making a 
selection in the Form Name box, AppsControl has inserted the correct Applica-
tion Name here. If not, type an application name here.  

• Block Name: This box accepts the names of field blocks that appear in the form 
you have selected. Type the name of the block that contains fields for which you 
want to create control rules.  

• WVR Enabled: This check box does not apply to Rapid Compliance (it indicates 
whether your chosen form is associated with a When Validate Record event, a dis-
tinction that is significant only for control types other than Audit). Accept what-
ever value is supplied automatically by AppsControl. 

Creating Control Rules for Fields in the Selected Block 
In the lower grid of the AppsControl Wizard, select individual fields and enter 
control-rule values for them. In each row of this grid, you can select values for one 
of the fields in the block you specified in the upper grid. 

1 Ensure that the Change Details tab is selected, then enter these values: 

• Field Name: Type the name by which the underlying code calls the field you 
want to control. 

• User Field Name: Type the user field name (the label visible to the user of an 
Oracle Application) corresponding to the Field Name you selected in the pre-
vious box. 

• Control Type: Select Audit, which is the only control type available in Rapid 
Compliance. 

• Enable: Select the check box to the right of a row to indicate that the change-
control rule it defines should be activated when rules are generated. Or clear 
the check box to turn off the rule.  

Instead, you can select or clear the All check box, at the upper right of the 
Change Details panel, to enable or disable all rules currently displayed in the 
panel. 

Note 
The Workflow Role and Reason Type fields do not apply to Rapid 
Compliance and so are disabled. 

2 Click on the Column Translations tab. 

• Under User Field Name, AppsControl supplies the display name of the field 
you want to control (it’s a copy of the value entered in the User Field Name 
box of the Change Details tab). You cannot change this value. 
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• Under Column Name, select the name of the database column that corre-
sponds to the value entered in User Field Name — the column that stores 
data entered in the field. 

Using the Translations Tab  
In the Translations tab, you identify the database table that stores data entered in 
fields on the block you selected under the Change Element tab. The values you select 
here are valid for all fields in that block.  

 
Click on the Translations tab and fill in the following values: 

• Display Prompt and Display Column: These items are appropriate for a full im-
plementation of AppsControl, and are not used by Rapid Compliance. However, 
software dependencies require that you enter values for them.  

Under Display Column, select the name of a field that identifies individual records 
to which changes apply (such as the field that displays the name of a vendor, if 
you are creating change-control rules for a block that displays information about 
vendors). Use the format BLOCK.FIELD, in which BLOCK is the name by which under-
lying code recognizes the form block that contains the field you want to use, and 
FIELD is the name by which underlying code calls the field you want. The block 
does not have to match the block you specified under the Change Element tab. 

Under Display Prompt, type a descriptive label for the Display Column field. 
Choose any label that has meaning for you. 

• Table Name: Select the name of the database table that corresponds to the block 
you specified under the Change Element tab. 

• Primary Keys: Click on the Import Primary Keys button. Under the label Primary 
Key Columns, AppsControl lists the names of the primary keys for the table you 
selected in the Table Name box. You cannot change these values. 
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• Form Field: For each database column name entered under the Primary Key Col-
umns label, type the name of the corresponding form field. Once again, use the 
format BLOCK.FIELD, in which BLOCK is the name by which underlying code rec-
ognizes the form block that contains the field, and FIELD is the name by which 
underlying code calls the field you want. 

Finishing the Control-Rule Generation 
When you complete the foregoing configuration tasks for any number of fields, you 
can generate rules that implement change control, either one at a time or collectively. 
To generate a single rule: 

1 Click on any of the tabs in the bottom grid of the Change Element form — 
Change Details, Column Translations, or Rules. 

2 Click on the row for which you want to generate a rule. A rectangle to its left 
turns blue. 

3 Click on the Generate Current Rule button. 

To generate any number of rules at once: 

1 Click on the Rules tab in the bottom grid of the Change Element form. 

2 Select the Generate check box for each of the rows for which you want to gener-
ate rules. Or, select the check box at the upper right of the Rules panel to choose 
all rows displayed in the panel for rule generation. (If you clear that check box, you 
deselect all rows from rule generation.) 

3 Click on the Generate Selected Rules button to create rules for all the rows you 
have selected. 

 
Once you have generated rules, click on Tools in the Oracle Applications menu bar, 
then on AppsAudit Compile Audit Objects in the Tools menu. Verify that the process 
has run successfully under View/Requests. 

Then click on the Rules tab. In each row, an Audit field displays the name of the audit 
group that applies to the controlled field. (The field corresponds to a database column, 
the column exists within a database table, and to track changes to columns in a table, 
AppsAudit places the table in an audit group.) Make a note of the group name for use 
as you create reports in AppsAudit on changes to controlled fields. The Rule Name 
and Process Name fields do not apply to Rapid Compliance, and so are blank.  
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Defining AppsAudit Reports  
Having created control rules in AppsControl, you can define and run AppsAudit 
reports that present information about changes in the database columns that cor-
respond to the controlled fields. You can create a new report definition or query a 
saved report definition. You can also select filter criteria for the report based on 
ranges of old and new values. Reports are executed via the concurrent request queue. 

To define reports, open AppsAudit (see page 3). Click on LogicalApps Utilities in 
the menu bar, and then on AppsAudit Report in the Utilities menu. The following 
Audit Report form appears: 

 

Audit Report Header 
To create a new report definition, begin by completing entries in the header area of 
the Audit Report form: 

1 In the Report Name box, type a name for the report. 

2 Make selections in either or both of the Group Name and Table Name lists of 
values.  

• In the Group Name field, you can select an audit group associated with con-
trolled fields in which you are interested. (As discussed on page 26, the Rules 
panel in AppsControl provides the name of the group associated with each 
field.) If so, the Table name field presents only tables belonging to the group 
you’ve chosen. You can select one of those tables to report only on auditing 
for it, or you can leave the Table Name field blank to report on auditing for 
all the tables in the group. 

• If you leave the Group Name field blank, the Table Name field displays 
tables belonging to all audit groups associated with controlled fields. Select 
one of the tables to report on auditing for it. 
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3 Specify a span of time the report should cover. Do one of the following: 

• Type or select starting and ending dates in the Start Date and End Date 
boxes. Use the format configured for your instance of Oracle Applications. 
(Note that the Start Date and End Date boxes default to the current date.) 

• Type a value in the Num of Days box. AppsAudit subtracts this value from 
the date the report is run and uses the resulting date as the start of a date 
range. The end date is the date the report is run. 

4 In the User Name list of values, select a user to report only on data changes 
made by that user. Or leave the box blank to report on data changes by all users. 

5 In the Report Style list box, determine the format of the report output by 
selecting either of the following: 

• Master Detail presents report information as blocks of data, each of which 
lists a table, information about its primary keys, and then a row of data about 
each of the audited fields that has changed. 

• Delimited File presents report information as records of data changes, each 
using a tilde to separate the individual values that make up a record. 

6 In the Debug Level list box, select High or Low. AppsAudit maintains data 
about both report generation and the audit “package” — the core generation of 
audit data from which a report gathers information. It places this data in a log 
table, where it may be reviewed if problems need to be resolved. The High 
debug-level value produces more detail and retains the data in the table. The Low 
value produces less detail and allows log data to be purged. Typically, select Low. 
(This setting does not alter the information presented in an audit report.) 

7 Select the Display IDs check box if you want the report to identify primary keys, 
or clear the check box if not. 

Audit Report Detail 
Once the header information is in place, click the Refresh button to select tables and 
columns for inclusion in the report. In response, AppsAudit fills the grid in the Audit 
Report form with entries for all columns selected for auditing: 

• If you selected a table name as you completed the report header, AppsAudit 
displays all the audit columns from that table. 

• If you selected a group name but no table name as you completed the report 
header, AppsAudit displays all the audit columns from all the tables of the group. 

For each, AppsAudit supplies the Table Name, Column Name, and User Column 
Name, and selects an Include in Report check box. In a Column Type list box, 
AppsAudit also provides the data type for the column; however, if the report is to 
present data from a lookup table, the data type shown here reflects the lookup value. 
For instance, if the audited column is VENDOR_ID but a lookup table is to provide 
VENDOR_NAME in the report, the data type is given as Character, not Number. 
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You can refine this automatically generated selection of columns:  

• Choose the columns you want in the report. For each column, click on the 
Include in Report check box to remove the check mark and therefore exclude 
the column from the report. Or click on the check box again to reinsert the 
check mark and reinclude the column in the report. 

Alternatively, click the Select All button to include all the columns or the De-
Select All button to exclude all the columns. Note, however, that you cannot 
exclude columns defined as primary keys. 

• Define ranges of values that filter report entries. 

For any column, type entries in the Old Value From and Old Value To boxes to 
report only data changes that begin with a value in the range you specify. For 
example, if a numeric field contained the value 6 and the data were changed, a 
record of that change would nevertheless be excluded from a report if you 
specify old-value-from and -to entries of 0 and 5. 

Similarly, type entries in the New Value From and New Value To boxes to 
report only data changes that end with a value in the range you specify. 

Note 
Filter values for two or more columns have an AND relationship — all must 
be true for the filter to return a result. For example, if you define an old-
value filter for a name column that permits only the name Smith (if that 
name is placed in both the From and To boxes), and an old-value filter for a 
date column that permits only a single date (if that date is placed in both the 
From and To boxes), then the report would display audited data only for 
records concerning Smith on the specified date. 

Resubmission Options 
You can schedule a report to be run repeatedly. To do so, select values in the block 
of the Audit Report form labeled Resubmission Options: 

• In the Type list box, select Hours, Days, or Weeks to designate the unit of time 
you use to define an interval at which the report is to be rerun. Or, keep the 
default selection, None, to prevent the report from being rerun. 

• In the Interval box, type a number that expresses the interval at which the report 
is to be run. For example, if you type 5 here and select Hours in the Type list 
box, the report is resubmitted every five hours. 

• In the Run Date From and Run Date To boxes, type or select dates and times 
that mark the beginning and end of the period in which the report should be run 
repeatedly. Again, use the format configured for your instance of Oracle 
Applications. 
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AppsAudit fills in these values: 

• The Scheduled check box indicates that the reporting cycle you have defined is 
being implemented. AppsAudit checks it when you submit the report. Once the 
date in the Run Date To box has passed, AppsAudit clears the Scheduled box. 

• The Request ID text box displays an identifying number for the most recent 
submission of the report. For instance, if a report runs four times per day, this 
box would at the end of the day display the fourth request ID. 

Saving and Submitting a Report 
When you are done selecting header, detail, and resubmission options, save the 
report definition: click on File in the menu bar and then on Save in the File menu. 

Once you have defined a report, click on the Submit Report button in the Audit 
Report form. When you do, a message similar to the following one indicates that the 
report is being generated: 

 
Note the request ID number, then click on the OK button to close the message. 

See Chapter 4 for information on viewing AppsAudit reports (as well as reports 
generated by AppsAccess and AppsControl). 

Other AppsAudit Features 
In addition to defining and running reports, you can set the “state” of audit groups 
and define lookup values for audited table columns. 

When you start AppsAudit, it opens to an Audit Groups panel. In Rapid Compliance, 
most of its functionality is read-only. It is here, however, that you can change the state 
of an audit group — in effect, disable auditing for a group: 

1 Query the audit group you want: Press the F11 key, type the name of the group 
in the Group Name field, and press the Ctrl+F11 key combination. 

2 In the State list box, select one of the following values: 

• Disable—Interrupt Audit: Auditing for the group is paused, and audit 
objects, including audit data, are preserved in shadow tables. 

• Disable—Prepare for Archive: Auditing for the group is stopped, and cur-
rent data for each row is stored in shadow tables, which can be archived. 

• Disable—Purge Table: Auditing for the group is stopped, and audit objects, 
including audit data, are dropped. 

From the Audit Groups panel, you can also click on an Audit Columns tab. This pro-
duces a panel in which, in a full implementation of AppsAudit, a user would be able 
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to select table columns that are to be audited. In Rapid Compliance, this function-
ality is disabled; the only way to select columns for auditing is to write AppsControl 
rules for form fields that correspond to the columns you want to select. However, 
the Audit Columns panel enables users to assign “translation values” to table col-
umns, and this functionality is active in Rapid Compliance.  

A translation value for a column is a corresponding column in a lookup table. A 
lookup column contains meaningful values that match up with values in audited 
tables, such as a person’s actual name in place of a numeric identifier.  

If you want audit reports to display actual values from an audited column, select No 
Lookup in its Translation Type list of values. 

 
If, however, you want audit reports to display a translation value for an audited 
column, join it to a corresponding column in a lookup table. Typically, you would 
specify a linkage among three columns: 

• The first is the column that contains an audited value. In the example illustrated 
above, this is CREATED_BY in the GL_JE_BATCHES table. 

• The second is a lookup-table column that contains an identifying value — the 
same value as in the audited table. In the example illustrated above, this is USER_ID 
in the FND_USR table. 

• The last is a column in the lookup table that contains the translation value. In the 
example illustrated above, this is USER_NAME in the FND_USR table. 

To create this linkage: 

1 In the Translation Type list of values, select Table Lookup. 

2 In the Lookup Table list of values, select the name of the lookup table you want. 
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3 In the Lookup Value list of values, select the name of the lookup-table column 
that contains translation values for the audited column. 

4 Move to the lower grid and, in the Translation Table Column list of values, select 
the lookup-table column that contains the identifying value. 

5 In the Type list of values, select the value Column. 

6 In the Audit Table Column list of values, select once again the column from the 
audited table that contains the audited value. 

In the lower grid, you can complete as many rows as you like to create a translation 
value as complex as you like. The rows have an AND relationship — all must be true 
for a value to be returned. 

To change translation values (once they’ve been saved), you must delete the existing 
values and then save the audit group before selecting new values. If you attempt to 
replace old translation values directly with new values, AppsAudit presents a message 
stating that you must first delete the old values and save the deletion. 

Once you’ve finished setting an audit state or defining translation values, save the 
new configuration: click on File in the menu bar, then on Save in the File menu. Or, 
click on the Save icon, located first on the left in the toolbar. 
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Chapter 4 

Reports and Concurrent Requests 

All three Rapid Compliance applications provide performance reports: 

• AppsAccess provides a set of reports that present not only the results of analysis 
for use in locating and resolving conflicts, but also data about rule configuration 
and user exclusions. Reports are available in text and PDF formats.  

AppsAccess also accepts “concurrent requests” — it runs utility programs that 
archive data, prepare export files or load import files, reset values, and generate 
user conflicts.  

• AppsControl presents a single report, which presents information about fields 
under control; it is also available in text and PDF formats.  

• AppsAudit produces reports, at the database level, on changes to fields that are 
subject to AppsControl rules. 

Generating Reports and Requests 
To generate any of the reports or requests available in AppsAccess or AppsControl, 
complete the following steps. (See pages 27–30 for information on generating reports 
in AppsAudit.) 

1 With the Logical Apps Navigator open, click on View in the Oracle Applications 
menu bar, then on Requests on the View menu. The Find Requests form appears 
(as shown at the top of the next page). 
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2 Click the Submit a New Request button. At the prompt, select Single Request 

and click OK. The Submit Request form appears. 

 
3 In the Name list of values, select the name of the report or request you want to 

run. Click on the OK button. 

4 If a report or request takes parameters, a Parameters form appears. To filter 
entries in a report or items subject to a request, select values for any number of 
parameters. Or, to include all possible entries or items, leave the parameters 
blank. Parameters vary from one report or request to another. (See the descrip-
tion of each report or request for a discussion of its parameters.) Click on the 
OK button. 

5 In the Submit Request form, click on the Submit button. At the next prompt, 
make a note of the request number; then click on Yes to run another report or 
request, or no to return to the Find Requests form. 

Viewing Report Results 
To view an AppsAudit, AppsAccess, or AppsControl report, or to check on the pro-
gress of a report or request, use the Find Requests form. It becomes active after you 
use the Submit Request form in AppsAccess or AppsControl. Otherwise, you can 
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open it (as before) by clicking on View in the Oracle Applications menu bar, then on 
Requests on the View menu.  

1 To see the results of a report, or check on the progress of a report or request, 
click on the My Completed Requests or My Requests in Progress radio button 
(as appropriate) and then on the Find button. Or click on the Specific Requests 
radio button, type your request number in the Request ID field, and click on the 
Find button. 

2 A Requests form shows the status of your request. When it informs you that the 
report is completed (you may need to click on the Refresh Data button), click on 
the View Output button. The report appears. 

AppsAudit Report 
The form that an AppsAudit report takes depends on the selection you made in the 
Report Style list box when you entered header information in the report definition. If 
you chose Master Detail, the report looks like this: 

 
If you chose Delimited File, the report looks like this: 
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AppsAccess Reports and Requests 
The following reports and requests are available in AppsAccess. 

Conflicts Summary Report 
The Conflicts Summary Report lists responsibilities within each application, then 
shows the number of approved, rejected, prevent, and pending conflicts, and the 
total of those four counts, at each responsibility. 

There are two ways in which a responsibility may be considered to be associated with 
an application: the first is a direct association, with a given responsibility linked to 
only one application. The second way is through the following linkage: an application 
is associated with a function, which is associated with a menu, which is granted to a 
responsibility. To ensure a correct count of both function-based and responsibility-
based conflicts for each application, the report bases its calculations on the second 
association. As a result, the report may show responsibilities within an application 
that are not directly linked to the application. 

Moreover, a given conflict is counted in each of the applications (base and conflict-
ing) it affects. A rule, for example, may define a conflict between two functions, each 
associated with a distinct application. If the rule were to generate 10 conflicts, the re-
port would show 10 conflicts in each of the applications, for a total of 20. 

As you generate the report, you can select these parameters: 

• Run Date: Select a date to view summary values for conflicts generated up to 
that date. This parameter is required. 

• Application: Select an application to view summary values for conflicts associ-
ated with that application. Or, leave the parameter blank to view summary values 
for conflicts associated with all applications. 

The Conflicts Summary Report looks like this: 
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Responsibilities with Conflicts Report 
The Responsibilities with Conflicts Report lists responsibilities for which conflicts 
exist, and identifies the components of each conflict as well as the rule that defines it. 
As you generate the report, you can select the following parameters: 

• Application Name: Select an application to view responsibilities that have 
conflicts associated with the application. Or leave the parameter blank to view 
responsibilities that have conflicts associated with all applications. 

• Responsibility: Select a responsibility to view only conflicts for that 
responsibility. Or leave the parameter blank to view conflicts for all 
responsibilities. 

• Function: Select a function to view only conflicts involving that function. Or 
leave the parameter blank to view conflicts involving all functions. You can select 
a function only if you have first selected an application. 

• Control Type: Select a control type — Prevent or Allow with Notification — to 
view only conflicts of that type. Or accept the default value, All, to view conflicts 
of both types or rule. 

• Conflict Within Same Responsibility: Select Y (for yes) to view information on 
conflicts between functions within a responsibility, or N (for no) to view 
information on conflicts between entities across responsibilities. Or leave this 
parameter blank to view information on conflicts of both types. 

The Responsibilities with Conflicts Report looks like this: 
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User Conflicts Report 
The User Conflicts Report presents information on the resolution of conflicts for 
individual users. It collects data generated when conflicts are resolved in the User 
Conflict Actions form. A system administrator would use information from the 
report to implement conflict-resolution decisions. As you generate the report, you 
can select the following parameters: 

• Snapshot Run Date: Select a date to view summary values for conflicts generated 
up to that date. This parameter is required. 

• Conflict Rule Name: Select a rule to view information on the resolution of 
conflicts generated by that rule. Or leave the parameter blank to see information 
on the resolution of conflicts generated by all rules. 

• Control Type: Select a control type — Prevent or Allow with Notification — to 
view only information on the resolution of conflicts generated by that type of rule. 
Or accept the default value, All, to see information on the resolution of conflicts 
generated by both types of rule. 

• User Name: Select a user ID to view only information on the resolution of con-
flicts concerning that user. Or leave the parameter blank to see information on 
the resolution of conflicts concerning all users. 

The User Conflicts Report looks like this: 
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Conflict Matrix Report 
The Conflict Matrix Report lists conflict rules and, for each rule, displays the values 
that define it. As you generate the report, you can select the following parameters: 

• Conflict Rule Name: Select a conflict rule to view information only about that 
rule. Or leave this parameter blank to see information about all rules. 

• Entity Type: Select Function or Responsibility to view rules that find conflicts in 
one entity or the other, or Both to see both types of rule. 

• Application Name: Select an application to view rules that involve that applica-
tion, or leave the parameter blank to view rules that involve any application. 

• Control Type: Select a control type — Prevent or Allow with Notification — to 
view only information on conflict rules involving that type. Or accept the default, 
All, to see information on conflict rules involving both types or rule. 

• Conflicts Exist: Select Y (for yes) to list rules for which conflicts exist or N (for 
no) to list rules for which conflicts do not exist. Or leave the parameter blank to 
list both types of rule. 

• End Dated Conflict: Select Y (for yes) to list rules for which conflicts are end-
dated or N (for no) to list rules for which conflicts are not end-dated. Or leave 
the parameter blank to list both types of rule. 

• Same OU: Select Y (for yes) to list rules that apply within operating units or N 
(for no) to list rules that apply across operating units. Or leave the parameter 
blank to list both types of rule. 

• Same SOB: Select Y (for yes) to list rules that apply within sets of books or N 
(for no) to list rules that apply across sets of books. Or leave the parameter blank 
to list both types of rule. 

The Conflict Matrix Report looks like this: 
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Application Conflict Report 
The Application Conflict Report lists conflict rules and, for each, provides informa-
tion about each user affected by the rule. As you generate the report, you can select 
the following parameters: 

• Snapshot Run Date: Select a date to view summary values for conflicts generated 
up to that date. This parameter is required. 

• Application Name: Select an application to view information about rules that 
involve that application, or leave the parameter blank to view rules that involve 
any application. 

• Conflict Rule Name: Select a conflict rule to view information only about that 
rule. Or leave this parameter blank to see information about all rules. 

• Entity Type: Select Function or Responsibility to view information about rules 
that find conflicts in one entity or the other, or Both to see information about 
both types of rules. 

• Control Type: Select a control type — Prevent or Allow with Notification — to 
view only information on conflict rules involving that type. Or accept the default, 
All, to see information on conflict rules involving both types of rule. 

The Application Conflict Report looks like this: 

 

User Exclusions Report 
The User Exclusions Report lists all of the persons who have been granted exemp-
tions for conflict-rule processing. Typically these are people, such as support person-
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nel, who might require substantial super-user access, but who do not actually carry 
out the responsibilities or functions that are in conflict. Such users would therefore 
generate many user conflicts even though the conflicts need not be tracked. The 
User Exclusions report does not take any parameters, and looks like this: 

 

Extract Conflict Rules 
The Extract Conflict Rules concurrent request generates a CSV (text) file that 
contains a record of each active conflict rule — each rule that is not end-dated. The 
file can then be used for uploading conflict rules into another Oracle Applications 
instance. The Extract Conflict Rules request takes no parameters, and it produces 
output looks like the following: 

 
Save the output as a CSV file in order to upload it to another instance. 

Load Conflict Rules 
The Load Conflict Rules concurrent request uploads conflict-rule definitions from a 
CSV file. That file is generated either by the Extract Conflict Rules concurrent request 
or from a spreadsheet provided by Logical Apps. For a detailed procedure for using 
the Load Conflict Rules concurrent request, see page 12.  
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Archive User Conflict Data  
The Archive User Conflict Data concurrent request archives records of older con-
flicts to a history table. This request takes, as its only parameter, a date in the format 
configured for your instance of Oracle Applications; the request archives conflicts 
generated before that date. 

Analyze Responsibility Conflicts 
The Analyze Responsibility Conflicts concurrent request runs conflict rules in order 
to reduce conflicts to the responsibility level. That is, before function conflicts can 
be recognized as applying to users, they must be recognized as existing in the respon-
sibilities that are assigned to users. The Analyze Responsibility Conflicts request per-
forms this step; running this request therefore speeds the process of generating user 
conflicts. This request takes no parameters. 

Generate User Conflicts 
The Generate User Conflicts concurrent request analyzes the assignments of respon-
sibilities to users and determines which assignments violate conflict rules. Running 
this concurrent request is equivalent to clicking the Generate User Conflicts button 
in the Conflict Matrix form (see page 14). This request takes no parameters. 

Cache WF User Roles 
The Cache WF User Roles request refreshes a table called laa_wf_user_roles, which 
holds workflow-role data used only by AppsAccess. Typically you need not run this 
request, because equivalent processing occurs each time user conflicts are generated, 
either through use of the Generate User Conflicts button (see page 14) or the Gener-
ate User Conflicts concurrent request (above). You may, however, choose to run it 
when a reviewer is updated in an AppsAccess rule or when there is an update to work-
flow roles used as AppsAccess reviewers. 

AppsControl Report 
In AppsControl, the Control Listing Report you all the objects you have under 
control. As you generate the report, you can select the following parameters: 

• Application: Select an application name from the list or leave the box blank. If 
you select a name, the report lists only controlled fields that apply to that applica-
tion. If you leave the box blank, the report lists controlled fields for all applications. 

• Form Name: Select the internal name for a form or leave the box blank. (To can 
make a selection in this box, you must first make a selection in the Application 
box.) If you select a form, the report lists controlled fields that appear in that 
form. If you leave the box blank, the report lists controlled fields for all forms.  

• Change Type: Select Audit (the only control type available in Rapid Compliance). 
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• Status: Select from the list to have the report list fields whose controls have been 
Disabled or Enabled, or leave the box blank to have the report include both types. 

The Control Listing Report looks like this: 
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Support 

Logical Apps offers many services to assist you with the Rapid Compliance imple-
mentation. From on-site support to remote phone and web support, our team of 
experienced professionals provides the help and information you need to ensure 
quick and effective implementation. The Logical Apps team includes a Technical 
Support Representative, an Account Manager, and a Logical Apps staff consisting of 
consultants and support specialists. 

Feedback 
Thank you for using Logical Apps Rapid Compliance. We value your comments and 
feedback. Mail your comments to the following address, or call us directly at (949) 
453-9101. 

Logical Apps 
Attn: Documentation Management 
15420 Laguna Canyon Road 
Suite 150 
Irvine, CA 92618 
U.S.A. 

Or send email to support@LogicalApps.com.  

 



Support  

46 Rapid Compliance User’s Guide  

 

 

 

 

 

 


	1.  Introducing Rapid Compliance
	AppsAccess
	AppsControl
	Other AppsRules Applications
	Starting Rapid Compliance

	2.  Segregation of Duties
	Finding Conflict Rules
	Creating Conflict Rules Manually
	Creating Global Subscribers
	Operating Units
	Submenus
	Data Groups
	Users
	Finishing the Subscriber Configuration

	Uploading Conflict Rules from a Spreadsheet
	Generating User Conflicts
	Reviewing User Conflicts
	Assigning Responsibilities to Users

	3.  Change Control
	Uploading Rules from a Content Spreadsheet
	Creating Control Rules Manually
	Finding Control Rules
	Determining Internal Names for Items Used in Rules
	Creating Control Rules
	Selecting a Block of Controllable Fields
	Creating Control Rules for Fields in the Selected Block
	Using the Translations Tab
	Finishing the Control-Rule Generation

	Defining AppsAudit Reports
	Audit Report Header
	Audit Report Detail
	Resubmission Options
	Saving and Submitting a Report

	Other AppsAudit Features

	4.  Reports and Concurrent Requests
	Generating Reports and Requests
	Viewing Report Results
	AppsAudit Report
	AppsAccess Reports and Requests
	Conflicts Summary Report
	Responsibilities with Conflicts Report
	User Conflicts Report
	Conflict Matrix Report
	Application Conflict Report
	User Exclusions Report
	Extract Conflict Rules
	Load Conflict Rules
	Archive User Conflict Data
	Analyze Responsibility Conflicts
	Generate User Conflicts
	Cache WF User Roles

	AppsControl Report

	Support

